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Syllabus: Pharmacology (1) (#131702361) 

First Semester 2021 /2022 
COURSE INFORMATION 

Course Name: Pharmacology(1) (face-to-face education) 

Semester: First         

Department: Clinical Pharmacy & Pharmacy Practice     

Faculty: Pharmaceutical Sciences 

Course Code: 131702361 

Section: According to the 

semester                 1, 2                    

Core Curriculum: 2019 Study  

                                Plan                  

Day(s) and Time(s):  According to the semester    

 

Classroom: According to the semester                  

 

Credit Hours:  3  

Prerequisites:  1917021253      

                         (Pathophysiology)          

COURSE DESCRIPTION 

 

Pharmacology is the study of drugs. This course will cover a brief introduction about pharmacology, 

pharmacokinetics, pharmacodynamics and receptors. Moreover, this course provides the students with 

the basic information of the drugs working on the autonomic nervous system (ANS), cardiovascular 

(CV) system regarding their mechanism of action, biotransformation, side effects, contraindications 

and their clinical uses. In addition, this course will introduce the students to several diseases affecting 

the CV system such as hypertension, heart failure, angina and cardiac arrhythmia and the classes of 

drugs that are available to treat these diseases. 

 

DELIVERY METHODS 

The course will be delivered through a combination of active learning strategies. These will 

include: 

• PowerPoint lectures and active classroom-based discussion  

• Relevant films and documentaries 

• Video lectures  
 

FACULTY INFORMATION 

Name Dr Abdelrahim Alqudah 

Academic Title: Associate Professor 

Office Location: Third Floor 

Telephone Number: Extension: 3437 

Email Address:       Abdelrahim@hu.edu.jo 

 

 الجامعـــــــــــــة الهاشمـيــــــــــــــــة

 

 The Hashemite University 
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Office Hours:            According to the semester   
 

CESRUOESR NGINRAEL NDA CESNEREEFR 

 

:(s)Required Textbook 
 

1. Katzung, Bertram G. Masters, Susan B. Trevor, Anthony J. Basic and clinical pharmacology. 

(McGraw Hill / Medical 14th edition. 2018) ISBN: 978-0-07-176402-5 

 

Suggested Additional Resources: 

 

2. Karen Whalen, Richard Finkel, Thomas A. Panavelil. Pharmacology (Lippincott Illustrated Reviews 

Series) (Wolters Kluwer 6th edition 2015) ISBN 978-1-4511-9177-6 

 

ourse ObjectivesC 

After completion of this course the student will: 

1. Develop basic knowledge of pharmacokinetic and pharmacodynamic principles. 

2. Identify most commonly used drugs in the major drug categories covered in this course. 

3. Develop basic knowledge about drug uses, mechanism of action, characteristics, side effects, 

interactions, kinetics and contraindications.  

4. Develop knowledge of key clinical notes about major drugs and how to administer them.  

5. Be able to retrieve relevant information about the drug from trusted online and offline resources.  

Learning Outcomes Course 

 A. Knowledge and Understanding 

A1: Differentiate between pharmacodynamics and pharmacokinetics principles, and recognize 

different types of receptors along with their signal transduction pathways. 

A2: Understand the drug development and regulation process, identify the pharmacology of 

autonomic nervous system and cardiovascular drugs, and distinguish prototype drugs that affect 

different body systems. 

A3: Know the primary resources for pharmacological information, and reflect on the role of the 

pharmacist in enhancing patient understanding of drug therapy as part of healthcare provision. 

 B. Essential for Practice and Care (Intellectual Skills): 

Analyze symptoms and relate them to possible side effects of certain drugs. -B.1 

Understand the relationship between drug effects and receptor binding, and explain how  -B.2

effects.receptor knowledge aids in drug design and the prediction of effects and side  

 

 C. Approach to Practice Pharmacy: 

Identify the uses of drugs covered in the course. -C.1 

 

Identify drug interactions among the medications discussed in the course. -C.2 
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Describe the predictable side effects of the drugs covered. -C.3 

 

D. Personal and Professional Development: 

Effectively communicate with others about the effectiveness and safety of drugs, evaluating  -D.1

information clearly and accurately. 
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ACADEMIC SUPPORT 
 

It is The Hashemite University policy to provide educational opportunities that ensure fair, 

appropriate and reasonable accommodation to students who have disabilities that may affect their 

ability to participate in course activities or meet course requirements. Students with disabilities 

are encouraged to contact their instructor to ensure that their individual needs are met. The 

University through its Special Need section will exert all efforts to accommodate for individual’s 

needs.    

Special Needs Section: 

Tel: 00962-5-3903333 Extension: 4209 

Location: Students Affairs Deanship/ Department of Student Welfare Services 

Email: amalomoush@hu.edu.jo 

            amalomoush@staff.hu.edu.jo  
 

COURSE REGULATIONS 
 

Participation 

Class participation and attendance are important elements of every student’s learning experience 

at The Hashemite University, and the student is expected to attend all classes. A student should 

not miss more than 15% of the classes during a semester. Those exceeding this limit of 15% will 

receive a failing grade regardless of their performance. It is a student’s responsibility to monitor 

the frequency of their own absences. Attendance record begins on the first day of class 

irrespective of the period allotted to drop/add and late registration. It is a student’s 

responsibility to sign-in; failure to do so will result in a non-attendance being recorded.  

 

In exceptional cases, the student, with the instructor’s prior permission, could be exempted from 

attending a class provided that the number of such occasions does not exceed the limit allowed 

by the University. The instructor will determine the acceptability of an absence for being absent. 

A student who misses more than 25% of classes and has a valid excuse for being absent will be 

allowed to withdraw from the course.  

 

On average, students need to spend 15 hrs of study and preparation weekly. At the beginning of the 

lectures, be on time and don't leave before the end of the lecture without an accepted excuse. If you 

missed a class, it is your responsibility to find out about any announcements or assignments 

you have missed. For any clarification, please communicate your instructor at her posted office 

hours or by appointment. Listen well to the lecture, if you have a question, ask your instructor. You 

will find the course material at the course team after the lecture. 

 

Sharing of course materials is forbidden. No course material including, but not limited to, course 

outline, lecture hand-outs, videos, exams, and assignments may be shared online or with anyone 

outside the class. Any suspected unauthorized sharing of materials, will be reported to the 

university’s Legal Affairs Office. If a student violates this restriction, it could lead to student 

misconduct procedures. 

 

 

mailto:amalomoush@hu.edu.jo
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Missed Assessments 

 

In all cases of assessment, students who fails to attend an exam on the scheduled date without 

prior permission, and/or are unable to provide a medical note, will automatically receive a failure 

grade for this part of the assessment. 

 

• In cases where a student misses an assessment on account of a medical reason or with prior 

permission; in line with university regulations an incomplete grade for the specific assessment 

will be awarded and an alternative assessment or extension can be arranged. 

 

Cheating 

Cheating, academic disconduct, fabrication and plagiarism will not be tolerated, and the university 

policy will be applied. Cheating policy: The participation, the commitment of cheating will lead to 

applying all following penalties together: 

• Failing the subject, he/she cheated at 

• Failing the other subjects taken in the same course 

• Not allowed to register for the next semester 

• The summer semester is not considered as a semester 

 

Student Complaints Policy 

Students at The Hashemite University have the right to pursue complaints related to faculty, 

staff, and other students.  The nature of the complaints may be either academic or non-

academic. For more information about the policy and processes related to this policy, you may 

refer to the students’ handbook.  

 

COURSE ASSESSMENT 
 

Course Calendar and Assessment 

 

Students will be graded through the following means of assessment and their final grade will be 

calculated from the forms of assessment as listed below with their grade weighting taken into 

account. The criteria for grading are listed at the end of the syllabus 
 

Assessment Grade Weighting Deadline Assessment 

First Exam 30% ~ 6th week 

Second Exam 30% ~ 10th week 

     Final Exam 40% ~ 15th /16th week 

 

Description of Exams 

Test questions will predominately come from material presented in the lectures. Semester exams 

will be conducted during the regularly scheduled lecture period. Exam will consist of a 

combination of multiple choice, short answer, match, true and false and/or descriptive questions.  

 

No make-up exams, homework or quizzes will be given. Only documented absences will be 

considered as per HU guidelines. 
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Grades are not negotiable and are awarded according to the following criteria:   

 
Letter Grade Description Grade Points 

A+ Excellent 4.00 

A  3.75 

A-  3.50 

B+ Very Good 3.25 

B  3.00 

B-  2.75 

C+ Good 2.50 

C  2.25 

C-  2.00 

D+ Pass 1.75 

D Pass 1.50 

F Fail 0.00 

I Incomplete - 
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WEEKLY LECTURE SCHEDULE AND CONTENT DISTRIBUTION 

 

“Lecture hours and weeks are approximate and may change as needed” 

Note: For the 2 lecture periods per week (S/T, M/W), one lecture period covers 1.5 lecture hours (75 

minutes). The course content specifies chapters of the textbook that will be included in exams. 

 

 
Topics Week 

No. of 

lectures 
Topic 1 Introduction: 

- General principles of pharmacology 

- Terminology and general introduction 

1 1 

Topic 2 Drug receptors & pharmacodynamics 1 1 

Topic 3 Pharmacokinetics 2 2 

 Drug biotransformation 3 1 

Topic 4 Drugs affecting the autonomic nervous System: 

- Introduction to autonomic pharmacology 

- Cholinoceptor-activating and Cholinesterase inhibiting 

drugs 

4 2 

 -Cholinoceptor-blocking drugs 5 2 

 -Adrenoceptor agonists & sympathomimetic drugs 6 2 

 -Adrenoceptor antagonist drugs 7 2 

Topic 5 Cardiovascular-Renal Drugs: 

- Diuretic agents 
8 2 

 - Antihypertensive agents 9 2 

 -Vasodilators & the treatment of Angina Pectoris 

-Drugs used in heart failure 

-Agents used in cardiac arrhythmias 

10-

11 

4 

Topic 6 Drugs used to treat diseases of blood: 

-Drugs used in disorders of coagulation 

12 2 

 - Agents Used in Dyslipidemia 13 2 

 -Agents used in anemias, hematopoietic growth 

factors 

14 2 

University 

Final 

Exams 

 15+ 

16 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.accessmedicine.com/content.aspx?aid=4518124
http://www.accessmedicine.com/content.aspx?aid=4518357
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٢٠٣٥٦١٦  ٢٠٣٥٣٣٣  ٢٠٣٥٢٠١  ٢٠٣٤٣٢٠  ٢٠٣٤٢١١  ٢٠٣١٩٠٣  ٢٠٣١٦١٠  ١٩٣٦٧٣٧  ١٩٣٦٣٦٤  ١٩٣٥٨٣١  
٢٠٤٠٨٨٠  ٢٠٤٠٧٦٤  ٢٠٣٩٢٦٧  ٢٠٣٨٤٠٨  ٢٠٣٨١٧٨  ٢٠٣٨١٤٣  ٢٠٣٧٤٩٦  ٢٠٣٦٤٤٩  ٢٠٣٦٤١١  ٢٠٣٥٩٩٣  

٢٠٤١٧٦٦ 

 

١٩٣٥٨٣١ 

١٩٣٦٣٦٤ 

١٩٣٦٧٣٧ 

٢٠٣١٦١٠ 

٢٠٣١٩٠٣ 

٢٠٣٤٢١١ 

٢٠٣٤٣٢٠ 

٢٠٣٥٢٠١ 

٢٠٣٥٣٣٣ 

٢٠٣٥٦١٦ 

٢٠٣٥٩٩٣ 

٢٠٣٦٤١١ 

٢٠٣٦٤٤٩ 

٢٠٣٧٤٩٦ 

٢٠٣٨١٤٣ 

٢٠٣٨١٧٨ 

٢٠٣٨٤٠٨ 

٢٠٣٩٢٦٧ 

٢٠٤٠٧٦٤ 

٢٠٤٠٨٨٠ 

٢٠٤١٧٦٦ 

 

Select a table and go to Edit → Replace → More → Special → Any digit → Format → Language → 

English . 

Place the cursor at "Replace with" → Format → Language → Arabic 

 

 

 

 


